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SQL Database Connectivity with Seagate Info

Overview
This document discusses what components are required on the Info Report Designer and Info
Report Server computers for proper SQL Database connectivity in Seagate Info (SI). In addition,
it includes detailed troubleshooting steps to help you resolve database connection problems at
schedule time. In particular, it explains how to troubleshoot the “Cannot Open SQL Server” error
for failed report instances and the “Unable to read database for Query” error for failed query
instances.
This document is for Seagate Info users and administrators and applies to Seagate Info versions
6.x and 7.x.
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Introduction
The “PEStartPrintJob: Cannot Open SQL Server” error is a very common scheduling error with
failed report instances in Seagate Info. It is a generic error that simply means that a database
connection could not be established at schedule time by the Info Report Server computer.
Common causes are:
•

An incorrect password was typed in the Logon tab during scheduling.

•

The ODBC data source being used for the report does not exist on the Info Report Server
computer.

•

The SQL database client was incorrectly installed or configured on the Info Report Server
computer.

There are many possible causes to this scheduling error and usually each cause has its own
solution. However, the troubleshooting procedure to diagnose this error is always the same.
Therefore, you can go through a detailed troubleshooting procedure to help isolate the cause to the
scheduling error and what steps you need to take to resolve the error.
This document discusses the following:
•

Before You Begin - Setup Requirements

•

Troubleshooting Scheduling Errors due to Database Connectivity Problems

•

Common Causes and Troubleshooting Questions

•

Troubleshooting Procedure for Diagnosing “Cannot Open SQL Server” Error for Failed
Report Instances

•

Troubleshooting Procedure for Diagnosing “Unable to read database for Query” Error for
Failed Query Instances

•

NT Service Issues

•

Specific Scenarios

Before You Begin – Setup Requirements
Report Designer Computer
What you need to have on the computer
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•

The 32-bit database client for your particular database must be installed on the computer if
you have installed onto a Microsoft Windows 9x, Windows NT, or Windows 2000 computer.

•

The 16-bit database client must be installed if you are running on Microsoft Windows 3.x or
3.11.

•

All ODBC drivers must be installed and registered on the computer.
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Info Report Server Computer
It is recommended to have the Info Report Server installed on a 32-bit operating system to
fully utilize processing power and resources. Windows NT computers are favored over
Windows 9x computers for four important reasons: security, stability, ability to run as an NT
service, and application\system logging abilities.

What you need to have on the computer
•

The 32-bit database client for your particular database must be installed on the computer if
you have installed onto a Microsoft Windows 9x, Windows NT, or Windows 2000 computer.

•

All ODBC drivers must be installed and registered on the computer.

NT Services
If the Info Report Server is going to be run as an NT service, then you must ensure that:
•

The ODBC Data Source used is a System DSN and not a User DSN.

•

The Info Sentinel NT Service is configured to use a domain user account with proper network
access to the database server.

Data Source Issues
•

The data source used by the report must be created on this computer with the same
configuration and name (with the name being case sensitive).

•

Also, the ODBC driver that is being used on this computer for the data source must match the
driver used on the computer where the report was created. In particular, the driver name and
version must be identical.

Troubleshooting Scheduling Errors due to Database
Connectivity Problems
At schedule time, in Seagate Info 7.x and 6.x, the following error message may occur on a failed
report instance “Cannot Open SQL Server”. In Seagate Info 5.0, this message would appear as:
“Info Server Error: Unable to Connect, Incorrect Logon Parameters”. In both cases, the report
failed to schedule because a database connection could not be established.
Report instances may fail with the error message “Cannot Open SQL Server”. Query instances,
on the other hand, may fail with the error: “Unable to read database for Query”. This error
indicates that the query failed to schedule because a database connection could not be established.

Common Causes and Troubleshooting Questions
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•

Has the correct logon information been supplied under the ‘LogOn’ tab in the schedule dialog
box? Entering the wrong database password will cause the report to fail at schedule time.

•

Check that the data source being used in the report has been created on the Info Report Server
computer and ensure that it has been configured to use the same driver.

•

Check to make sure that the database client has been installed and configured correctly on the
Info Report Server computer.
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•

Can the report be previewed in the Report Designer on the Info Report Server computer (by
logging onto the computer using the same user account that the Info Report Server is
configured to run under)?

•

Can the report be scheduled from the Info Desktop on the Info Report Server computer (using
the same user account that the Info Report Server is configured to run under)?

•

If the Info Report Server is running as a NT service, stop this service. Logon to the computer
with the same user account that the Info Sentinel service was configured to run under. Start
the Info Sentinel from the program group. When the Info Report Server is running as an
application (instead of NT Service), can the report be scheduled from the Info Desktop on the
Info Report Server computer (using the same user account that the Info Report Server is
configured to run under)?

Troubleshooting Procedure for Diagnosing “Cannot Open SQL Server”
Error for Failed Report Instances
To troubleshoot and diagnose the cause of the “Cannot Open SQL Server” scheduling error for
failed report instances:
1. You MUST go to the Info Report Server computer where the report failed at schedule time.
Reason: The report needs to be processed on the Info Report Server computer (and not on
the client computer). As a result, if a problem or error occurs, you can only troubleshoot it
from the Info Report Server computer.

2. For troubleshooting purposes, you MUST have the Info Desktop and Info Report Designer
components installed on this Info Report Server computer. If you need to troubleshoot query
objects, the Info SQL Designer (or Info Query Designer in versions prior to Seagate Info 7.x)
needs to be installed on the Info Report Server computer. (If they are not, you can perform a
custom install of Seagate Info to get these components onto the computer.)
3. If the Info Report Server is on a Windows NT 4.0 computer, click Start > Settings > Control
Panel. Then, double-click Services.
Check the following NT service: Info Sentinel. Is it 'Started' and set to 'Automatic'? This will
indicate if the Info Report Server is running as an NT service or not.
4. If it is not running as an NT service, then proceed immediately to step 5.
If it is running as an NT service, then click Stop to stop the Info Sentinel NT service. Check
what user account it is configured to run under. Log off the Windows NT 4.0 computer and
logon again with this Seagate Info service user account. Proceed to the next step.
5. Go to the Seagate Info program group and start the Info APS (if you have both the Info APS
and Info Report Server on this computer). If this is only an Info Report Server computer, start
the Info Sentinel from the program group.
6. Start the Info Desktop. Schedule the same report that failed previously to the SAME Info
Report Server where you are at currently. Does this return as 'Success'?
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•

If yes, the problem is diagnosed to only occur when running as an NT service. As a
result, focus on the section: “NT Service Issues”.

•

If no, (i.e. running the Info Report Server as a process led to a 'Failed' instance status),
then proceed to the next step.
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7. On the Info Desktop for Windows, right-click the report object and click Design. (In versions
6.x and 5.x, this option will appear as ‘Design Report Object’.) Refresh the report in the
Report Designer (by clicking on the lightning bolt button on the tool bar) and click to the last
page. Does the report preview successfully? Yes or No.
If ‘Yes’, then close the report in the Report Designer. Go back to the Info Desktop for
Windows. Right-click the report object and click Properties. Click Refresh and click OK.
Then, try to re-schedule the same report. What happens?
•

If the report still fails with the error “Cannot Open SQL Server”, then in the Info Desktop
for Windows, on the Tools menu, click Options. In the section for 'Schedule Settings',
ensure that the checkbox for: "Use current login id and password for all schedule logons"
is clear. If it was previously selected, attempt to reschedule the same report with this
checkbox cleared.

NOTE

This particular Info Desktop setting is ONLY to be used in cases where one has unified the
database logon account with the Seagate Info database account.

If ‘No’, then please check the following:
•

Ensure that the 32-bit database client is properly installed and configured on the Info
Report Server computer.

•

Can a connection be made to the database using a NATIVE connection tool that comes
with the database client?

•

Has the data source name being referenced in the main report (and all subreports, if any)
actually been created on this Info Report Server computer? If yes, is it configured with
the same data source settings as well as using the same driver and version?

NOTE

To check the data source name being used for the report:
1. Start the Report Designer and open the report.
2. On the Database menu, click Set Location.
3. In the Location box, check the value for Server Name. This is the data source being
used for the report.

•

Try creating a new report off the same ODBC data source that was being used for the
problem report. Does this also give an error message?

•

If the report is using an ODBC driver to connect to the database, use a third party ODBC
connection tool to test ODBC connectivity to the database via the ODBC data source that
was chosen for the report. You can use the Crystal Decisions tool called: Sqlcon32.exe.
This can be obtained from the Crystal Decisions web site at:
http://support.crystaldecisions.com/communityCS/Filesandupdates/sqlcon32.zip Follow
the Readme.txt instructions included in the .zip file.

•

Can a successful connection to this ODBC data source be made in this third party ODBC
connectivity tool?
If a connection CANNOT be made, please ensure that your Database Administrator
resolves this problem before proceeding on with scheduling your reports to this Info
Report Server.
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Troubleshooting Procedure for Diagnosing “Unable to read database for
Query” Error for Failed Query Instances
To troubleshoot and diagnose the cause to the “Unable to read database for query” scheduling
error for failed query instances, follow the same steps detailed in the section: ‘Troubleshooting
Procedure for diagnosing “Cannot Open SQL Server” error for Failed Report Instances.’
The only differences will be that any reference to “report” should be replaced by “query”. Also,
any reference to opening the report object in the Info Report Designer should be replaced by
opening the query object in the Info SQL Designer on the Info Report Server computer.
NOTE

‘Info SQL Designer’ is the name given in SI 7.x but in SI 6.x and 5.x, this component was
called ‘Info Query Designer’.

A query object can be opened in the Info SQL Designer on the Info Report Server computer by
right-clicking the query object and clicking ‘Design’. (In versions 6.x and 5.x, this option will
appear as ‘Design Query Object’.)
A logon dialog should appear at this point and you should be entering the password to see if the
query actually runs in the Info SQL Designer.
NOTE

If a data source dialog appears instead, this is a clear indication that the data source the
query object was created with does NOT exist on this Info Report Server computer. As a
result, it would have led to a failure when attempting to schedule the query object.

NT Service Issues
Here is a list of items to be aware of when running the Seagate Info components as an NT service
under Windows NT or Windows 2000:
1.

2.

ODBC Data Source names (DSNs)

•

You need to have a System DSN defined, as an NT service cannot read a User DSN.

•

Ensure that any duplicate User DSNs are removed from the computer (if they have the
same name as a defined System DSN).

Current directory for loading of DLLs

When running as an NT service, it appears that the current directory switches from the
application directory to the \Winnt\System32 directory. If you have multiple copies of a DLL
on the computer, this could affect from where the DLL is loaded. Consequently, it will cause
inconsistencies in versions of DLLs that load and thereby will cause errors to occur.
3.

Environment variables

Windows NT has two sets of environment variables: User and System. User variables cannot
be accessed by an NT service. Thus, any information that is required in an environment
variable must be in a System environment variable. (For example, Informix installs its
database client directory into the PATH under a user environment variable instead of the
system PATH.)
4.

NT user account

This is not NT service-specific but often it gets overlooked. If you want to run the Seagate
Info components as an NT service under a certain user account, then ensure that this account
6/26/2002 4:26 PM
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can run the Seagate Info components as processes (i.e. running as an application by starting
the component via the program group).
5.

Info Sentinel NT Service account requirements

The Info Sentinel NT service should be configured under a proper domain user account (that
is part of the Local Administrators NT group on this server computer). This will ensure that
the user account has proper access to network resources, such as a database server. [The same
requirement must follow if the Info APS and Info Agent NT services are to be configured on
this computer.] Please talk to your Windows NT Administrator to verify this user account
information.
6.

Mapped drives

An NT service does not have access to any network drives. This can be an issue if you are
scheduling a program object. If the program requires a file as a parameter, it must be a UNC
path and not a mapped drive location.
7.

Oracle and Informix based Reports – NT Services

For reports created off an Oracle or Informix database, there are important NT service specific
issues to be aware of. Please refer to the following knowledge base articles on our web site:
•

C2000757 - Reports based on Oracle 7.3 database fail when SCI runs as a NT service
http://support.crystaldecisions.com/kbase/C2000757.asp
In essence, what needs to be does is to compare all DLLs in the \Orant\Bin directory on
the Info Report Server to those which may reside in the \Winnt\System32 directory on the
same computer. All duplicates in the \Winnt\System32 directory should be renamed to
.OLD extension to ensure that they do not load.

•

C2000756 - Informix Reports & Queries fail when running SCI components as NT
Services
http://support.crystaldecisions.com/kbase/C2000756.asp

Specific Scenarios
Other scenarios will cause a failed connection to the database at schedule time. These are listed
below.

(Scenario A – Database was in Single-User Mode)
Symptom:

Scheduled reports fail with the error: “Cannot Open SQL Server”.
Cause:

The Database Administrator (DBA) had set up a DBCC (Database Connectivity Check) process to
run on the database server every morning at 4:30 a.m. The DBCC runs until about 5:45 a.m., and
sets each database to single-user mode to check it. Since the DBCC process was already in the
database, no one else could log on to it. This caused the reports to fail with the error message
"Cannot Open SQL Server", even though the logon information was correct.
Solution:

Changing the report time, so that it completed before the DBCC started, allowed the reports to run
successfully.

6/26/2002 4:26 PM
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(Scenario B - “Use current login id and password for all schedule logons”
had been turned on)
Symptom:

A ‘Business User’ install of Seagate Info had been done to two client computers. A report off a
Microsoft SQL Server database can be scheduled correctly off the first client computer and it runs
correctly (i.e. returns a ‘Success’ status). However, when the same report is scheduled off the
second client computer, the report fails with the error: “Cannot Open SQL Server”. As a result,
the problem seems to be specific to only one of the client computers that had scheduled the report.
Observations:

It is observed in the Schedule dialog, for the Logon tab, that the User ID shown is NOT the same
as what is stored in the .RPT file. (To find out what User ID is stored in the .RPT file, open the
report object in the Info Report Designer. Then, on the Database menu, click Set Location. It
will be shown on this dialog box.)
The report object was refreshed on the Info Desktop for Windows (i.e. right-click report object
and click Properties and then click Refresh). However, when going back to the Schedule dialog
under the Logon tab, it was observed that the User ID shown was still incorrect. Why is this
behavior happening?
Cause/Solution:

In the Info Desktop for Windows, on the Tools menu, click Options. In the section for 'Schedule
Settings', the checkbox for: “Use current login id and password for all schedule logons” was
selected. (When this checkbox was cleared and the report was rescheduled, the error no longer
occurred.)
This setting for “Use current login id and password for all schedule logons” should ONLY be
turned on in environments where the database user account (i.e. User ID and password) has been
synchronized with the Seagate Info user account (i.e. User ID and password). That way, with this
checkbox on, the password will always be pre-populated in the Schedule dialog and does not need
to be filled in by the user every time the user schedules.
An enhancement has been forwarded to our development team regarding the ability for the SI
Administrator to have a GLOBAL setting to set “Use current login id and password for all
schedule logons” and thus remove it as a client only setting. This will allow the SI Administrator
to control this setting for all users (i.e. in this case, to have this option OFF for all users).
NOTE

Seagate Info 7 has a new feature called ‘Server Defaults’, which can be set in the Properties
for a Report Object. This would define the default User ID and Password to be used to fill in
the Logon tab at Schedule time for this particular report object only.

(Scenario C – Multiple copies of the P2sodbc.dll being loaded into memory)
Symptom:

When attempting to schedule reports, they fail with the error “Cannot Open SQL Server”. This
error message is returned even if the scheduled report is based off an ODBC DSN connection to
an Access database, such as the sample database that ships with Seagate Info (craze.mdb). The
report opens fine in the Info Report Designer (on the Info Report Server), can be refreshed without
error, and new data is retrieved.
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Observations from Diagnosing:

A new System DSN was created off a sample Access database, followed by creating a new report
to read from that DSN in the Info Report Designer. Again, the report runs in the Info Report
Designer on the Info Report Server but returns a ‘Failed’ status with the error “Cannot Open SQL
Server” when scheduled.
Cause:

From observation, it was noticed that when creating a new report on this Info Report Server
computer, the logon server dialog box was displaying duplicates of all the DSNs from both the
User DSN and System DSN lists in the ODBC Administrator.
In the Info Report Designer, if all the ODBC entries are being duplicated, it is possible that two
P2sodbc.dll files are being read. It could be that in the \Windows\System or \Winnt\System32
directory, there is a P2sodbc.dll and a P2sodbc.old.dll.
Solution:

The best thing to do is do a wildcard search for P2sodbc*.* on all local drives on the local
computer. Ensure that one file exists with the name P2sodbc.dll and that it is located in the
\Winnt\System32 directory (on Windows NT 4.0 computers) or in the \Windows\System directory
(on Windows 9x computers). The following is the version of the P2sodbc.dll that is installed with
the specific version of the Seagate Info product as a new install or upgrade:
•

For Seagate Info 7.0.2.200, the version of the P2sodbc.dll is 7.0.100.47.

•

For Seagate Info 7.0.2.100, the version of the P2sodbc.dll is 7.0.100.28.

•

For Seagate Info 7.0.2.0, the version of the P2sodbc.dll is 7.0.0.139.

•

For Seagate Info 6.x and 5.x, the version of the P2sodbc.dll is 6.0.0.68.

(Scenario D – Info View Reports)
Symptom:

Users are scheduling reports that are based on Info Views. In addition, these users do NOT have a
database user account on the database server. In the Scheduling dialog, under the Logon tab, no
password is entered at schedule time. The result is that the Info View reports fail with the error:
“Cannot Open SQL Server”.
Cause/Solution:

In environments where end users do NOT have a database account and Info Views are being used
as a meta-layer or data dictionary for the report, the users need to be given the SI security right
called: “Reuse Info View Logon”. This is found in the Info Administrator under the Groups and
Users tab. Once this right has been granted, at schedule time in the Schedule dialog, the Logon
password will be pre-populated for the user; thus, they do not need to fill in anything under the
Logon tab at schedule time.
NOTE
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It is critically important that on the Info Report Server, the report file MUST be able to resolve
the path to the .CIV file (as this is where the encrypted database password will be stored). If
it cannot be resolved and you are using the “Reuse Info View Logon’ security feature so that
entering a database password is not required, then the report will fail with the error message:
“Cannot Open SQL Server” at schedule time. A UNC path to the .CIV file must be used in the
report when the Info Report Server is running as an NT Service.
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(Scenario E – Microsoft SQL Server and ‘Use Trusted Connection’ for
Report Data Source)
Symptom:

A report based on a Microsoft SQL Server database using a trusted connection can be previewed
in the Info Report Designer on the client computer. However, when the report is scheduled on the
Info Desktop, it fails with the error message:
"PEStartPrintJob : Cannot open SQL Server."
Cause:

When using Microsoft SQL Server trusted connection, the account that the Info Sentinel is using
to run on the Info Report Server computer must be a valid user account in the SQL Server
database.
For example, if the Info Sentinel component is running as an NT service under the account
"jsmith" with a password of "admin", the account "jsmith" and password "admin" must exist in the
SQL Server database in order for a trusted connection (otherwise known as Windows NT
authentication) to work.
If SQL Server does not recognize the account passed by the trusted connection, the Info Report
Designer will prompt for a user name and password. However, as this cannot be prompted for and
typed in at schedule time, the report fails.
Solution:

Crystal Decisions recommends that you deploy and configure ODBC data sources for Microsoft
SQL Server databases on Info Report Server computers as follows:
•

Ensure that the checkbox for ‘Use Trusted Connection’ is clear.

•

Ensure that the authentication method you choose is “SQL Server authentication” and not
“Windows NT authentication”.
NOTE

The ‘Use Trusted Connection’ checkbox or “Windows NT authentication” option setting in the
ODBC Data Source Administrator allow for the same logon information to be used in
environments where the Windows NT user account is synchronized with the database user
account. So, Windows NT Authentication is used. Thus, a logon dialog box is not required to
authenticate the user since the existing logged in NT user’s account information will be used
to authenticate against the database server.

When scheduling Seagate Info reports from the Info Desktop, the ‘Logon’ tab in the Schedule
dialog box exists to authenticate the user. Thus, the ODBC data sources on the Info Report Server
computer should be configured to use ‘SQL Server authentication’ instead.

(Scenario F – Report based on Microsoft SQL Server database)
Symptom:

When trying to schedule a report based on a Microsoft SQL Server database from the Info
Desktop, it fails. After checking the Properties for the failed report instance, the error message is:
"PEStartPrintJob: Cannot open SQL Server".
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Cause:

The scheduled report was based on a Microsoft SQL Server database. The issue was caused by
the configuration of Microsoft SQL Server. Specifically, on the database server, the Tempdb
space was too small and needed to be expanded.
Solution:

To resolve this problem:
1. Start the SQL Server Enterprise Manager.
2. Expand the server tree.
3. Expand the database devices folder.
4. Right-click on Tempdb device and click 'Edit'.
5. Increase the size of the device in Mb.
6. Click 'Change Now'.
NOTE

You cannot make the Tempdb smaller once you increase it and choose 'Change Now'. It is a
permanent commit to the database once you have chosen 'Change Now'.

After the Tempdb device space was expanded on the database server, the reports could be
scheduled and processed successfully.

(Scenario G – Scheduling in Pre-Version 7 Info Desktop Client)
Symptom:

A Seagate Info version 6 Info Desktop is connected to a version 7 Info APS. Scheduling a report
in this older Info Desktop client results in a ‘Failed’ instance status and the error:
"PEStartPrintJob: Cannot Open SQL Server".
Steps to Reproduce:

1. On a SI 7 Info Desktop, right-click on a SI 7 report object (based on a Microsoft SQL Server
6.5 database) and click Properties. Click the Servers tab.
2. Double-click the entry Database Logon(s).
3. In the Edit Default dialog box, type your database password in the default database logon.
Click OK twice.
4. From the SI 7 Info Desktop, in the Schedule dialog box under the Logon tab, notice that the
Logon Password is pre-populated from the Servers default setting for the report object. As a
result, from a SI 7 Info Desktop, the report schedules successfully WITHOUT a user needing
to enter a database logon password.
5. Next, go to a Seagate Info version 6.0.2.x computer and start the 6.0.2.x Info Desktop.
6. Right-click the same report object and click Schedule. The Schedule dialog box appears.

6/26/2002 4:26 PM
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7. Click the Logon tab. Notice that the Logon Password is not pre-populated. Do not type a
database logon password.
8. Click Schedule so that the same report object can be processed. The scheduled report fails
with the error: "PEStartPrintJob : Cannot open SQL server".
Cause:

Old Info Desktop computers do not recognize the database logon default Server setting which is
set in the Properties of a Seagate Info 7 report object. As a result, scheduling this report in an old
client Info Desktop will lead to a 'Failed' instance and the error: "PEStartPrintJob : Cannot open
SQL Server".
NOTE

The Servers tab in the properties of a report object in Seagate Info 7 is a new desktop
feature. Older versions of the Info Desktop will not be aware of features newer than itself.
As a result, it is impossible that it will recognize the Servers default database password
setting. Thus, the default logon will not be passed to an older Info Desktop client.

Solution:

The work around is to manually enter the database password at schedule time if an older Info
Desktop client is being used with Seagate Info 7.
Info Desktop client computers should be upgraded to the current release to take advantage of new
features such as Server defaults.

Scenario H – Scheduled SMS report fails with “Cannot open SQL Server”
Symptom:

Scheduling a Microsoft Systems Management Server (SMS) report on the Info Desktop results in
the report failing to process and returning a ‘Failed’ instance. In the properties of the Failed’
instance, the following error message is shown:
" PEStartPrintJob : Cannot open SQL server"
The Info Sentinel on the Info Report Server is running as a Windows NT service. When running
the Info Sentinel as an application (i.e. Start > Programs > Seagate Info > Info Sentinel), the report
schedules successfully.
The report can be previewed successfully in the Info Report Designer on the Info Report Server
using the same username and password.
Resolution:

Adding the user account used for the Info Sentinel service to the local computer's ‘Seagate Info’
NT group allowed the reports to schedule to success on the Info Desktop. This ‘Seagate Info’ NT
group had been granted the following additional advanced rights in Windows NT:
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(Scenario I - "Unable to open database" – Scheduling Reports based on
Query Files)
Symptom:

When scheduling report objects based on a query file (.QRY) as input, the reports may fail with
the error: “unable to open database”. This error may be more prevalent if the Info Report Server is
running as an NT service.
Cause/Solution:

Open the report object in the Info Report Designer.
There are 2 causes for this message at schedule time:
1. On the Database menu, click Set Location. Check the path to the query file. Is this a valid
path to the query file with proper read access to the file?
2. On the Database menu, click Set Location. Check the path to the query file. In particular, is
this a UNC path or physical drive location path? When the Info Report Server is running as a
NT service, it can only resolve UNC paths; as a result, the path to the .QRY file should be
defined as a UNC path. Once this change has been made, save and then close the report in the
Info Report Designer. Next, refresh the report object on the Info Desktop. (To refresh the
report object, right-click the report object and click Properties. Click Refresh and then click
OK.)
For further information, please refer to the following knowledge base articles:
•

C2000793 – “Changing Database | Set Location dialog for CIV and QRY in Info Report
Designer”
http://support.crystaldecisions.com/kbase/C2000793.asp

•

C2006495 – “Report against Microsoft Access fails with ‘PEStartPrintJob: Unable to
open database’ ”
http://support.crystaldecisions.com/kbase/C2000793.asp

(Scenario J – SI 4.5 and Computer Upgraded to ODBC 3.0)
Symptoms:

Here are various symptoms with Seagate Info 4.5 reports being scheduled on a computer with an
ODBC 3.0 layer:
•

When scheduling a 4.5 report in Seagate Info 4.5, it fails with the error: “Unable to Connect,
Incorrect Logon Parameters”.

•

When analyzing a successfully scheduled report in Seagate Info 4.5, the following message
occurs: "no saved data".

•

At schedule time, if you click the Logon tab in the Schedule dialog, it says ‘DEFAULT’ for
the name of the ODBC Data Source.

Cause:

For Seagate Info 4.5 users, problems occur when they upgrade their Windows NT Server
computer from Windows NT 3.51 to Windows NT 4.0.
The primary problem is that if NT 4.0 Server Service Pack 3 (SP3) is installed, a newer version of
the ODBC layer gets installed, which is ODBC 3.0.
6/26/2002 4:26 PM

Copyright  2001 Crystal Decisions, Inc. All Rights Reserved.

SI_DB_Connectivity.pdf

Page 14

Seagate Info

SQL Database Connectivity with Seagate Info

Windows NT 3.51 comes with ODBC 2.5 while Windows NT 4.0 SP3 comes with ODBC 3.0.
The problem is that the ODBC driver(s) that shipped with Seagate Info 4.5 may NOT be
compliant with ODBC 3.0. As a result, some of the previously mentioned symptoms may occur
when these Seagate Info 4.5 reports are scheduled on a computer with ODBC 3.0.
Solution:

Either schedule the reports to a Windows NT Server running ODBC 2.5 or obtain an ODBC 3.0
compliant ODBC driver from Crystal Decisions.

What Information to Provide to Technical Support
This document should have helped you identify the cause of your scheduling error when it is a
result of a database connectivity error.
If this entire document has been followed step by step and the report still fails with one of the
errors “Cannot Open SQL Server”, “Unable to read database for Query”, or “Unable to open
Database”, then ensure the steps below are followed. In addition, ensure that all pertinent
information is provided to the Technical Support Representative.
1. You will need to call from the Info Report Server computer that is experiencing the problem
with processing scheduled report or query objects.
2. Is the problem with scheduling a query or report object?
3. If a report is being used, what is the source for the report: Info View, Query file, ODBC
connection to the database, or native connection to the database?
4. What database and version are being used for the report? (Examples of reporting databases
are: Microsoft SQL Server, Oracle, Sybase, Informix, Microsoft Access, Btrieve, and so on.
5. In the Info Report Designer on the Info Server computer, open the problem report object. On
the Database menu, click Set Location. What does it say for ‘Server Type’ and ‘Server
Name’?
6. Ensure that the Info Sentinel on this Info Report Server is NOT running as an NT service.
Ensure that it is started through the Program Group for Seagate Info. This will shorten the
troubleshooting time required. (If this computer also acts as an ‘Info APS’, the ‘Info APS’
would need to be started through the Program Group as well and NOT be running as a NT
service.)
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Appendix
How to create an ODBC Data Source for your database
This procedure explains how you can create an ODBC data source for the database you plan on
reporting from. Before you begin this procedure, ensure that you have properly installed and
configured the database client on your computer.
To create an ODBC data source:
1. Start the ODBC Data Source Administrator. (In most Windows platforms, click Start >
Settings > Control Panel. You will see a 32-bit ODBC icon, with a slightly different name
depending on your operating system.)
•

In Windows NT 4.0, double-click ODBC Data Sources.

•

In Windows 2000, double-click Administrative Tools and then double-click Data
Sources (ODBC).

2. In the ODBC Data Source Administrator, click the User DSN tab (if one exists).
NOTE

Either a User DSN or System DSN can be used on the client computer. On the Seagate Info
server component computers (Info Report Server, Info APS) you must use System DSNs
ONLY. The name of the DSN used on the client must be identical to the one that will be used
on the Info Report Server and is case-sensitive. There cannot be a User DSN and System
DSN of the same name on a computer, even if they are different cases.

3. Click Add.
4. A list of installed ODBC drivers will appear. Double-click the driver that is appropriate for
the database that is being used. For example, if Microsoft SQL Server is your database, then
the driver to double-click is SQL Server.
5. Depending on the ODBC driver, certain information must be filled in. For example, type in
the data source name, server name, database name, and so on.

Creating a report that uses the Data Source created
This procedure explains how you can create a report in the Report Designer based on an ODBC
data source for the database you plan on reporting from. To create a report based on an ODBC
data source:
1. Start the Report Designer.
2. On the File menu, click New. The Report Gallery dialog box appears.
3. Click Custom and then click SQL/ODBC. The Log On Server dialog box appears, which
displays a list of data sources on your computer.
4. Click the data source that you want to use and click OK.
5. After selecting the data source, you are prompted to log on to the database.
6. After the logon has succeeded, a list of tables will be displayed. You can now choose tables
to be used for the report.
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Finding More Information
For Microsoft Systems Management Server (SMS) based reports, typical causes and resolutions to
the "Cannot Open SQL Server" error message can be found in the document, Seagate Info 6.x for
Microsoft Systems Management Server (SMS) 2.0: How to run Seagate Info from within SMS –
Getting Started Guide. The file name is SI6_SMS_Get_Started.pdf and be viewed or downloaded
at:
http://support.crystaldecisions.com/communityCS/TechnicalPapers/SI6_SMS_Get_Started.pdf.
Specifically, in this document, navigate to the major section "Common Errors and
Troubleshooting" and then to the subsection "Cannot Open SQL Server".

Contacting Crystal Decisions for Technical Support
We recommend that you refer to the product documentation and that you visit
our Technical Support web site for more resources.
Self-serve Support:

http://support.crystaldecisions.com/
Email Support:

http://support.crystaldecisions.com/support/answers.asp
Telephone Support:

http://www.crystaldecisions.com/contact/support.asp
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